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Symbols and Conventions

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

AN
Jia

(Windows), (Windows
only), (Macintosh), or
(Macintosh only)

Bold font

Ttalic font

Courier Bold font

Ctrl+key or mouse action

A note provides important related information, reminders,
recommendations, and strong suggestions.

A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.

This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list
indicate that you perform one of the actions listed.

This text indicates that the information applies only to the specified
operating system, either Windows or Macintosh OS X.

Bold font is primarily used in task instructions to identify user interface
items and keyboard sequences.

Italic font is used to emphasize certain words and to indicate variables.
Courier Bold font identifies text that you type.

Press and hold the first key while you press the last key or perform the
mouse action. For example, Command+Option+C or Ctrl+drag.




If You Need Help

If You Need Help

If you are having trouble using your Avid product:

1.

Retry the action, carefully following the instructions given for that task in this guide. It is
especially important to check each step of your workflow.

. Check this ReadMe file for the latest information that might have become available after the

documentation was published. Also check online for the most up-to-date ReadMe because
the online version is updated whenever new information becomes available. To view the
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at
http://www.avid.com/readme.

. Check the documentation that came with your Avid application or your hardware for

maintenance or hardware-related issues. In addition to the printed documentation supplied
with your editing application, the documentation is supplied in PDF format when you install
the application. Topics that you print from the Help have limited page layout and formatting
features. If you want to print a higher quality version of Help information, Avid recommends
that you print all or part of the PDF version of the appropriate Avid manual included in the
Online Library for your editing application. To access the Online Library, select Help >
Online Library from within your Avid editing application.

. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24

hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error
messages, to access troubleshooting tips, to download updates, and to read or join online
message-board discussions.

Changed in v7.0.3 and v11.0.3

The following changes were made in Media Composer v7.0.3 and NewsCutter v11.0.3.

OS Support Updates

m

The following Operating Systems have been qualified with this release of the editing application:

Windows v8.1
Mac OS v10.8.5, v10.9

(Macintosh) If you upgrade your Mac OS to v10.9, note there are known QuickTime issues. For
details see this Knowledge Base article.

(Macintosh) Note the following if you use Promise drives: Avid Video Raid SR (Promise 16
drives) will not be supported on MAC OS v10.9. ATTO specific drivers for Avid Video Raid SR
are not available for this new OS.


http://avid.force.com/pkb/articles/en_US/troubleshooting/Mac-OS-10-9-support-for-Media-Composer-Pro-Tools-Sibelius?popup=true&NewLang=en&DocType=1078&q=mavericks&site=kbase&filter=0
http://www.avid.com/readme
http://www.avid.com/onlinesupport

Changed in v7.0.3 and v11.0.3

% UDevC00182512: Currently, the Matrox hardware does not support Windows v8.1. If you are on
a Windows v8.1 system, disconnect your Matrox hardware to bootup properly. See
www.matrox.com to ensure you have the latest version of the Matrox software.

Updated NVIDIA Driver

The Nvidia Drivers supported with this release are:
v320.78 - for use with Windows 7 and Windows 8 systems.

v331.65 - for use with Windows v8.1 systems.

Effect Palette Change

To help organize the effects in the Effects Palette, the video and audio effects are now displayed
under the applicable tab. To access video effects, click the Video tab in the Effect Palette. To
access the audio effects, click the Audio tab.

Using the Mark Markers Button with Spanned Markers

The following shortcuts have been added when working with Spanned Markers:



Changed in v7.0.3 and v11.0.3

Shortcut

Description

Alt+ Mark Markers button-

If within a spanned marker, markers are applied to
the spanned marker’s range.

Shift + Alt + Mark Markers button - (NewsCutter only) If within a spanned marker,

audio markers are applied to the spanned marker’s
range.

Background Progress Indicator Changes

When files are placed in a Dynamic Media Folder, you will see a progress indicator in the
Timeline that indicates the progress of the background progress. The icon colors have been
updated. The See table below for a description of the progress indicator status.

State

Description

Solid green dot

Spinning with or without a
green center dot

Grey

Yellow

Icon with yellow triangle.

[ 4
o
=

Not spinning and no center dot.

You can access the DMF folder to ingest the assets into
your bin.

This indicates that background processing is in progress.

This indicates that the background services have been
suspended. To restart the services, select Tools >
Background Services and click Start.

This indicates the background service is paused. To restart a
paused background service, select Tools > Background
Services and click Start.

This indicates that no background processing is in progress
and there are no DMF assets to ingest.

If any of the progress icons appear with a yellow triangle,
an error has occurred during previous background
processing. Right-click the progress indicator and select
Generate Error Report in Console. The yellow triangle will
remain until you generate an error report.




Changed in v7.0.3 and v11.0.3

Support for 24 Frame Sound TC in 23fps or 24fps Non-PAL Projects

Previously, Sound TC was only supported at SD video rates (25 or 30). Historically, sound
recording devices generally worked at 30 or 25 based timecode. Now that most 23 or 24 rate
production uses 24 based timecode we have added support for this timecode rate for 23 or 24
based projects. The following explains how support has been added for 24 frame Sound TC in
projects with rates of 23fps or 24fps (excluding 24p PAL).

There are two main ways to enter Sound TC into the editing application: ALE import and bin
entry.

ALE Import

A new global title (not a column heading) has been added to the ALE format. This new element
is called SOUNDTC_FPS and defines the number of frames per second for Sound TC in the
ALE. Acceptable values are 30 or 24. If the SOUNDTC_FPS element is missing, you will be
prompted to select the Sound TC rate if there is a Sound TC column in the ALE.

The SOUNDTC_FPS element is ignored with a warning in non 23 or 24 rate or PAL 24p
projects.

If Sound TC already exists when performing an ALE merge, the new rate defined in the ALE or
selected by you will be used.

Manual Entry of Sound TC

When entering Sound TC manually in the bin, you will be prompted for the Sound TC rate if
there is no Sound TC for that clip. If Sound TC is already entered for this clip, the rate of the
current Sound TC will be used. Thus, you must clear the Sound TC field if you wish to change
the Sound TC rate.

When duplicating columns into the Sound TC field, you will be prompted for Sound TC rate for
clips with empty Sound TC fields only. Clips with already defined Sound TC will re-use that rate
when duplicating columns into the Sound TC column.

Transfer Setting Option

A checkbox has been added to the Transfer Settings option: “Minimum resolution warning
threshold.” The Minimum resolution warning threshold allows you to specify the lowest
resolution allowed to transcode before a warning message is displayed. The warning is on by
default. If you do not want the warning to appear, deselect this option.



Changed in v7.0.3 and v11.0.3

Frame Blending Option in Render Settings

Use frame blending in Motion Adapters: When clips of a different frame rate than the sequence
are dropped on the Timeline, a motion adapter is automatically applied. Motion Adapter effects
allow mixed rate clips to play at the project's frame rate and to have the correct field motion.

The frame blending setting will give you some flexibility with mixed-rate media by offering a
choice between temporal smoothness and spatial smoothness. It controls whether or not any new
motion adapters use the Blended Interpolated render option.

When this option is selected, the Blended Interpolated mode is used. The behavior is the same as
previous versions of Media Composer, and uses Blended Interpolated for most motion adapters.
When it is not selected, the Interpolated Field mode is used for interlaced clips, and Both Fields
mode is used for progressive clips.

Changing this setting does not have any effect on existing motion adapters. If you want to apply
this to an existing motion adapter, you will need to reload the cross-rate source clips into the
source viewer after changing the setting.

Exporting a Simplified AAF

A new “Link To Effects Mixdown” export setting allows you to mix down both audio and video
effects so that the exported AAF references only master clips. This might be useful for
workflows with third party applications, such as Telestream® that want to link to the exported
AAF media for further encoding. When the video is mixed down, if a segment of the video is an
existing master clip or filler, a reference to that segment is added to the new sequence. If the
segment is a transition or effect, a video mixdown occurs which creates a new master clip. The
new mixed-down master clip is added to the project bin and a reference is added to the new
sequence. For the audio mixdown, the editing application can limit the number of tracks included
in the exported sequence to the first 2, 4, 8, or 16 tracks. If an audio track contains at least one
effect or gain change, the entire track is mixed down to a new master clip. The new mixed-down
master clip is added to the project bin and a reference is added to the new sequence.

To perform a simplified AAF Export:

1. In the Project Window, click the Settings tab and select the Export Link to Effects Mixdown
setting.

If the setting does not appear, click the User Profile Selection menu and select Update User
Profiles. The new setting appears in the settings list.

2. Select the sequence you want to export as a simplified AAF.
3. Select File > Export.
4. Click Options.

The Export Settings dialog opens.



Changed in v7.0.3 and v11.0.3

5. Select AAF from the Export As menu.

6. Leave the following options enabled: In the Video/Data Details pane, the Mixdown
Video/Effects to V1 is enabled. In the Audio Details pane, Flatten Audio Tracks that Contain
Effects is enabled.

7. Select the number of audio tracks to include in the sequence.

8. Select the Media Destination Drive where you want to save any newly created media. (This
should be a drive that your third party encoding application has access to.)

9. Click Save.
10. Select a location for the AAF file, name the file and click Save.
The AAF file is saved to the selected location.

Proxy Resolutions

The following proxy resolutions are available for all media creation except Capture.



Changed in v7.0.3 and v11.0.3

Project Proxy Resolution

1080i50 H.264 800Kbps Proxy
H.264 2.0Mbps Proxy

1080159 H.264 800Kbps Proxy
H.264 2.0Mbps Proxy

1080p23 H.264 800Kbps Proxy
1080p24 H.264 800Kbps Proxy
1080p25 H.264 800Kbps Proxy
1080p29 H.264 800Kbps Proxy
23pNTSC H.264 800Kbps Proxy
24pNTSC H.264 800Kbps Proxy
24pPAL H.264 800Kbps Proxy
25iPAL AVCIBP-BLL2.0

H.264 800Kbps Proxy
H.264 1500Kbps Proxy

25pPAL H.264 800Kbps Proxy

30INTSC AVCIBP-BLL2.0
H.264 800Kbps Proxy
H.264 1500Kbps Proxy

720p23 H.264 800Kbps Proxy
720p25 H.264 800Kbps Proxy
720p29 H.264 800Kbps Proxy
720p50 H.264 800Kbps Proxy

H.264 2.0Mbps Proxy
AVCIBP-BLL3.0
720p59 H.264 800Kbps Proxy

H.264 2.0Mbps Proxy
AVCIBP-BLL3.0

10



Fixed in v7.0.3 and v11.0.3

Compatibility with Interplay Media Indexer Patch

Interplay Media Indexer Patch v3.0.50.12224 contains a full installer and has the following
installation requirements:

Older editor versions will continue to run with the patched Media Indexer servers but they will
still exhibit the following international character problem:

*  The patch must be installed on all Media Indexer v3.0.x servers.

*  The patch must also be installed on the following Avid editing systems if they have local
Media Indexers:

- Media Composer v7.0.3
- NewsCutter v11.0.3
Bug Number: UDevC00181301. The Media Indexer would show an .mxf file as offline if the file

name contained international characters. This means that you could not perform a Send to
Playback operation on a sequence that contained international characters in the name.

Avid Artist Color

The responsiveness of the Avid Artist Color Controller has been improved with this editing
application release.

Support for Russian Language

This version of the editing application supports the Russian language.

Fixed in v7.0.3 and v11.0.3

The following were fixed in Media Composer v7.0.3 and NewsCutter v11.0.3.

»  Bug Number: UDevC00181932. If your sequence contained audio, sometimes you could not
perform a redo after performing an undo operation.

»  Bug Number: UDevC00182424. Rendering imported media with effects such as AniMatte,
Scrolling titles, paint effects, resulted in corrupted media.

»  Bug Number: UDevC00180521. The responsiveness of the Avid Artist Color Controller has
been improved with this editing application release.

11



Fixed in v7.0.3 and v11.0.3

Bug Number: UDevC00181287. When both Segment Mode ad Extract Smart Tools are active,
in some instances dragging a clip would start in one mode and change to the other mode before
the drag was complete.

Bug Number: UDevC00182627. Performing a Perf Slip on an AMA linked Auto-Sync sub-clip
that contained motion, spatial, or color adapters resulted in an “Only subclips can be slipped by
perforation” error message.

Bug Number: UDevC00181905. Clips that have had their color space changed in the source
settings did not play in Quad Split source view.

Bug Number: UDevC00182064. In some instances, you could not render effects that had been
added to a decomposed sequence.

Bug Number: UDevC00181631. Some column headings were cleared after performing an ALE
import with “Merge events with known masterclips” selected in the Import Settings.

Bug Number: UDevC00178812. (Marketplace) The editing application might freeze after
selecting the AMA Plug-ins tab for a second time.

Bug Number: UDevC00181149. Reverse Match Frame was not working properly. In Film
projects with perf slip, performing a reverse match frame on a sequence in the Record monitor
with audio tracks enabled and a sub-clip in the Source monitor, resulted in the blue position bar
going past the end of the sub-clip.

Bug Number: UDevC00181075. Anymix Pro and Waves Panner Plug-ins did not appear in the
RTAS menu.

Bug Number: UDevC00181114. (Title Tool - Mac Only) A shadow layer might have appeared
on video after adding a rolling title.

Bug Number: UDevC00181911. You might have received crashes or segmentation faults
intermittently when changing the name of a sequence.

Bug Number: UDevC00181538. When connected to Black Magic 1/0, you would receive
acquisition errors when switching to the Title Tool and then back to the editing application.

Bug Number: UDevC00181079. On keyboards without a numeric keypad, pressing the Ctrl key
twice quickly, then pressing Shift and the + key and entering a value and pressing enter did not
move the Timeline position bar.

Bug Number: UDevC00181078. The numeric entry box would disappear if you pressed the ‘f’
key.

12



Changed in v7.0.2 and v11.0.2

»  Bug Number: UDevC00181326. In some instances, when comparing imported BWAV files to
AMA linked BWAV files, there was a discrepancy in the FPS and Duration columns.

»  Bug Number: UDevC00181709. Performing an AMA link to a file of a different project rate did
not warn the user of the frame mismatch. Any mismatch between the project rate and the file’s
internal rate will be reported in the console, along with the details of how the start time was
computed.

»  Bug Number: UDevC00181681. In some instances, AMA linked Sound Devices BWAV clips’
were 3 frames longer than expected.

»  Bug Number: UDevC00181697. In some instances, AMA linked Sound Devices BWAV clips’
cut into sequences were too short.

»  Bug Number: UDevC00181700. AMA linked BWAV clips’ timecode might have drifted over
time.

»  Bug Number: UDevC00181771. When in Effect mode, adding a 3D Warp might have resulted
in “Effect Analysis” appearing in the Source Monitor. If you then pressed Command + Y, the
editing application might have crashed.

»  Bug Number: UDevC00181734. The “Circled” bin heading was not available when AMA
linking to BWAYV using the WaveAIFF AMA plug-in.

Changed in v7.0.2 and v11.0.2

The following changes were made in Media Composer v7.0.2 and NewsCutter v11.0.2.

Avid Attic Change

An additional option has been added to the Bin Settings. The option “Always keep one version of
a bin in Attic” has been included with this release. This option is on by default and when enabled
will always keep at least one version of each bin in the Attic. (Note: This enabled position is how
previous releases of the editing application kept versions in the Attic.)

If you deselect this option, older bins may have all Attic versions removed to keep to the Max
Files limit.

13



Changed in v7.0.2 and v11.0.2

Services Name Change

The Avid Editor Services Manager has been renamed to Avid Background Services Manager.
There is no functional change. The icon to access the services appears in the menu bar
(Macintosh) task bar (Windows).

XDCAM EX 35 Capture

With this release, you can select XDCAM EX 35 for capture for any project types that support
XDCAM EX.

Dynamic Bin Naming (DMF)

The editing application allows you to set the bin name according to custom bin columns. The
metadata for the custom bin columns is added by the AMA plug-in. For example, if the plug-in
your 3rd party device has metadata for custom columns such as a reporter’s name, entering that
in the Specify bin name text field will use that when naming the target bin. You can choose to set
the bin name when setting up the Profile for your DMF folder.

To specify the bin name:

1. To setup the DMF folder, follow the procedure described in “Creating Dynamic Media
Folders” in the Help.

2. When you are setting the Profile for the DMF Folder click the Bins menu bar and select
Create New Bin and select Specify Bin Name.

14



Fixed in v7.0.2and v11.0.2

3. Enter the bin name, for example, { CustomColumnName} - { CustomColumnName}

The custom name is case sensitive. You must enter the exact custom column headings in
brackets. You cannot enter any of the default bin column headings such as Format, Aspect
Ratio, Audio Bit Depth, etc.

Fixed in v7.0.2and v11.0.2

The following were fixed in Avid Media Composer v7.0.2 and NewsCutter v11.0.2.

»  Bug Number: UDevC00180204. AMA QuickTime Alpha settings have been moved from the
Import Settings to the AMA Settings. Ignore, Invert, and Don’t Invert appear in the Link Options
of the AMA Settings.

»  Bug Number: UDevC00181105. In some instances, m2ts files did not AMA link.
»  Bug Number: UDevC00180346. The “DMF Services is not running” dialog was confusing. If
either background transcode or DMF is not running, the message will be “Avid Editor Services

are not Running.”

»  Bug Number: UDevC00180129. When the User Interface was set to a dark setting, the Mark In,
Mark Out and Phantom marks appeared with white markings around them.

15



Fixed in v7.0.2and v11.0.2

Bug Number: UDevC00181221. Play would stutter and performance would lag when using
Fast scrub with Caps Lock On and performing a reverse scrub.

Bug Number: UDevC00180459. A DNxHD QuickTime movie created with Spectrum
Mediaport hardware did not AMA link.

Bug Number: UDevC00181096. The position indicator would get stuck in the Timeline
between the Mark In and Mark Out points when using the keyboard and mouse.

Bug Number: UDevC00180468. In some instances, the space bar and other keys did not
immediately respond when pressed.

Bug Number: UDevC00180757. The Aspect Ratio was not properly detected for import of
certain media.

Bug Number: UDevC00180401. An asterisk now appears next to the mandatory fields in the
AS-11 export dialog.

Bug Number: UDevC00181101. The Source Settings now appear in the Clip menu. This allows
you to map to a keyboard or button. You can use this menu option if a bin is active and has an
appropriate selection, or if the Composer Window is focused with the Source monitor active and

a clip is loaded.

Bug Number: UDevC00181097. In some instances, video and audio were not playing while
performing a trim.

Bug Number: UDevC00180819. The Gain control slider incorrectly appeared on audio filler in
the Timeline. It now only appears on audio clips.

Bug Number: UDevC00180862. (NewsCutter) The Markers column was missing in the bin.

Bug Number: UDevC00180362. (Macintosh) You might have received errors when playing
back certain types of AMA linked BWF files.

Bug Number: UDevC00180597. With waveforms enabled in the Timeline, playback of AMA
linked six channel audio .wav files might have resulted in errors.

Bug Number: UDevC00179632. The editing application was slowed down when performing a
DMF Copy and Transcode of QuickTime files.

Bug Number: UDevC00180299. (Macintosh) Installing the editing application on a system with
Sibelius installed might have overwritten the Sibelius license.

16



Fixed in v7.0.2and v11.0.2

Bug Number: UDevC00179607. The editing application would either crash or display a
segmentation fault error when enabling Waveform displays on Sony Raw clips.

Bug Number: UDevC00179361. (NewsCutter) In some instances, you could not move the DMF
window.

Bug Number: UDevC00180272. If you linked to an AMA volume and then switched focus to
another application, a Indexing dialog appeared when you switched focus back to the editing
application.

Bug Number: UDevC00176769. The wireframe disappeared from the viewer and was displayed
in the Effect editor after performing an Undo.

Bug Number: UDevC00178759. The previous frame would flash in the Source monitor after
stopping playback in Group Clip mode.

Bug Number: UDevC00179231. Overwriting an AMA-linked file in After Effects might have
resulted in a “File in Use” error.

Bug Number: UDevC00178766. (Macintosh) Pressing Shift + dragging to highlight track
selectors did not always work.

Bug Number: UDevC00179759. When clip gain was enabled, Timeline audio clips displayed
0.0 value. The numeric display is only required for non-zero values.

Bug Number: UDevC00180327. Exported Wave and QuickTime files did not always contain
the Master Fader effects.

Bug Number: UDevC00180870. Dragging and dropping an RTAS effect while playing resulted
in a “Segmentation fault” error.

Bug Number: UDevC00179898. The Start timecode for an AS-11 clip export was incorrect.

Bug Number: UDevC00179794. An AS-11 Export did not export if the bin containing the
sequence was not the selected bin.

Bug Number: UDevC00172455. Performing a Find on audio metadata did not always display
AutoSync subclips made from those audio clips in the results window.

Bug Number: UDevC00180447. You no longer need to have DX hardware attached to use the
mouse jog/shuttle for playback.

17
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Fixed in v7.0.2and v11.0.2

Bug Number: UDevC00177470. The AMA Relink option is now available for AMA
QuickTime files with Alpha.

Bug Number: UDevC00180415. Consolidating an AMA XDCAM MXF sequence resulted in a
“Scanning volumes for media” error message that took a long time if the consolidation started

while waveforms were drawing in the Timeline.

Bug Number: UDevC00180290. If the cursor was on the top ruler in the Timeline, you could
inadvertently scroll vertically when trying to scroll horizontally.

Bug Number: UDevC00180019. The AMA Plugin is now listed in the DMF profile Summary
pane.

Bug Number: UDevC00179997. A warning message will warn the user when stopping services
that a job that is in progress will be stopped.

Bug Number: UDevC00180614. In some instances, dragging and dropping to the clipboard
Monitor resulted in a crash.

Bug Number: UDevC00180190. Turning pan knobs on the Audio Mixer Tool did not update the
numeric display until the mouse click was released.

Bug Number: UDevC00179163. You could not playback MP4 files linked through DMF.
Bug Number: UDevC00179170. You could not transcode an MP4 file through DMF.

Bug Number: UDevC00179210. You could not AMA link to 720p29 XDCAM EX 2 card
spanned clips.

Bug Number: UDevC00179030. (AS-11) The editing application became unresponsive when
linking to an AS11 file using Autodetect.

Bug Number: UDevC00179122. You could not transcode an XAVC clip in a non-native frame
rate.

Bug Number: UDevC00180078. (AS-11) Performing an SD export created an invalid MXF file.
Bug Number: UDevC00179575. (AS-11) Exported files contained invalid product information.

Bug Number: UDevC00179543. You might have received an “SFPlayConsumer::Execute
Timeout” error when loading a Sony F65 clip in the Source/Record monitor.

18



Fixed in v7.0.2and v11.0.2

Bug Number: UDevC00180560. In some instances, the Timecode was wrong after performing
a background consolidate of LongGOP clips with non-zero origin.

Bug Number: UDevC00180422. Background transcodes failed on Fat32 volumes.

Bug Number: UDevC0180333. Background transcodes of XDCAM OP1la were much slower
than foreground transcodes.

Bug Number: UDevC00177224. You might have received “AvidSphere_LocalHost” errors
when uploading p1080p 29.97 proxy clips.

Bug Number: UDevC00179214. OP1a exports did not import properly to the Sony Content
Browser software.

Bug Number: UDevC00179076. Typing Command +. to cancel a consolidation of an AMA
linked XDCAM sequence resulted in a hang or a sharing violation.

Bug Number: UDevC00180240. Spanned markers appeared on all Timecode tracks that were
displayed. They now only appear on a single Timecode track.

Bug Number: UDevC00177996. FrameFlex viewer showed corrupt image or AMA linked
XDCAM EX clips.

Bug Number: UDevC00180616. Color metadata was not read properly from YCbCr for AMA
linked clips.

Bug Number: UDevC00180001. A Freeze Frame was offline in a sequence if the original media
it was generated from was deleted.

Bug Number: UDevC00180116. You can now properly resize the DMF Profile Editor window.

Bug Number: UDevC00177819. Background transcoded clips displayed as Media Offline
inside the bin until they were loaded into the Source monitor.

Bug Number: UDevC00179798. (AS-11) The File name in the AMA File export window was
populated with the clip name from the last AMA-linked file.

Bug Number: UDevC00178819. In some instances, placing an AMA linked clip in the Timeline
resulted in the cursor appearing as a blue spinning donut inaccurately indicating the application

was busy.

Bug Number: UDevC00178979. Sliders would redraw with artifacts in the Effect Editor.
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New in Media Composer v7.0 and NewsCutter v11.0

»  Bug Number: UDevC00179284. Adding a second Data Track using the Add Track dialog did
not notify you if the track had already been created.

»  Bug Number: UDevC00177871. Clicking the Spanned Marker icon in the Source monitor, did
not consistently open the Marker window.

»  Bug Number: UDevC00180023. The text in the AMA link dialog indicating the Services were
not running was difficult to read.

»  Bug Number: UDevC00180010. The Interplay login window did not hide the inserted
password.

»  Bug Number: UDevC00179926. The icon for a batch imported matte key was not correct if that
clip was originally AMA linked.

»  Bug Number: UDevC00179452. The Cursor changed improperly on the Timeline audio gain
mini fader if Smart Tools were ON.

»  Bug Number: UDevC00179815. In some instances performing a Fit to Fill resulted in a blue
unrendered effect in the Timeline.

»  Bug Number: UDevC00180367. Pressing FF/RW keys stopped on all markers, whether they
were hidden or not.

»  Bug Number: UDevC00177901. Pressing FF/RW keys stopped on locations where there were
no markers present.

New in Media Composer v7.0 and NewsCutter v11.0

For information on new features, see the What’s New pdf.

With this release, additional services are installed with the editing application. If you uninstall
v7.0 or v11.0 of the editing application, you must also uninstall the Avid Editor Transcode from
the Add Remove Control Panel.
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Before Installing the Editing Application

Before Installing the Editing Application

Change to AVCHD AMA Plug-In

IMPORTANT: (Windows Only) In releases prior to v7.0/11.0, the AMA AVCHD plug-in had its
own installer. The plug-in was installed in Program Files\Avid\AVX2_Plug-ins\ AMA\AVCHD.
If you are upgrading from a version prior to v7.0/11.0, you must uninstall the AVCHD plug-in
from the Control Panel before you install the editing application. Then install the editing
application. The AVCHD plug-in will get installed to this location: C:\Program Files\Avid
\EditorApplicationName\ AVX2_Plug-Ins\AMA\AVCHD.

Interplay Sphere and Avid Editing Application

Bug Number: UDevC00180038. If you uninstall all Interplay Sphere components (Interplay
v2.7) and then install Media Composer v7.0 or NewsCutter v11.0, the editing application does
not install Editor Transcode, which is needed in non-Sphere configurations for background
consolidate and transcode operations. Avid editing applications in a non-Interplay Sphere
configuration must install Editor Transcode separately after uninstalling the previous version of
Sphere components.

If you want to use background consolidate and transcode with Media Composer v7.0 or
NewsCutter v.11.0 after uninstalling Sphere components, install Editor Transcode from the
following location in your Avid installer folder: \ISSetupPrerequisites\Avid Editor
Transcode\setup.exe.

Installation Information

Read through the Installation Guide for Avid Editing Applications. This document is available on
the Knowledge Base.

Important: This is a full version of the editing application. You should uninstall the
previous build from your system before you install Media Composer v7.0.3 or NewsCutter
v11.0.3.

Media Composer v7.0.3 is the first release supporting Mac OS v10.9. If you had upgraded your
system to Mac OS v10.9 on an editing version prior to v7.0.3, the uninstaller for that previous
editing application would not uninstall the editing application successfully. The v7.0.3
uninstaller do successfully uninstall previous 7.x editing applications.

Download Note

To avoid “File Path too long” or a “File cannot be copied” warning while unzipping the
downloaded installer, try placing the installer .zip on the root level of your C:\ drive and unzip it
from that location.
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After Installing the Editing Application

User Right to Raise Thread Priority

(Windows) Note for Domain Administrators: If your editing systems are part of a domain, you
must give the user the right to “Increase Scheduling Priority.”

This must be done within the Domain Group Policy on the domain controller by giving the right
explicitly to the user or giving the right to a group and adding the user to that group. You will not
be able to launch as a regular user if this is not set properly.

Install as Administrator

You need to first install the editing application, EDL Manager, FilmScribe and MediaL.og, as an
Administrator. If you are in a Shared Storage environment, mount your workspaces as an
Administrator. You may then log off and log back in as a Standard user, if necessary.

After Installing the Editing Application

Additional Services Installed with the Editing Application

Additional services are installed when you install the editing applications. These services are the
Avid DMF Service and Avid Editor Transcode Service. These services are turned off by default.
If you want to use these features, you must start the services. See “Starting and Stopping Avid
Background Services” on page 22.

AMA Plug-Ins

You cannot install the AMA Plug-ins while the editing application background services are
running. Make sure you Stop the services before installing the AMA Plug-Ins. The stop/start
background services icon is on the menu bar (Macintosh) or taskbar (Windows). Once you install
the new AMA plug-in, restart the services. See “Starting and Stopping Avid Background
Services” on page 22.

Not all third party plug-ins are available for release with Media Composer v7.0 and
NewsCutter v11.0. For information on AMA plug-in compatibility with this editing application
release, see the following Knowledge Base article. AMA Plug-in compatibility.

Starting and Stopping Avid Background Services

The editing application installs a Background Transcode service and a Dynamic Media Folder
service. The minimum memory supported for using these features is §GB RAM, although Avid
recommends 16GB RAM for using Background Transcode and Dynamic Media Folders. These
services are off by default. You must turn the Avid Services On if you want to use either
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After Installing the Editing Application

Background Transcode or Dynamic Media Folders. You can choose to turn the services on or
off either from the taskbar (Windows) or menu bar (Macintosh). Or you can choose to stop, start,
or pause the services from within the editing application.

To Start and Stop the Avid Services Outside the Editing Application:

1. Click the Avid Background Services Manager icon in the menu bar (Macintosh) or right +
click the Avid Background Services Manager icon in the task bar (Windows) and choose to
Stop or Start the services.

Start Avid Background Services

Stop Avid Background Services

Open Background Queue

Quit

The icon changes color to represent the state of the services; green (services active) - gray
(services not active) or orange (services paused).

2. To restart the services, click the Avid Background Services Manager icon (Macintosh) or
right + click the Avid Background Services Manager icon (Windows) and choose to Start the
services.

If you choose to Quit the Avid Background Services, the icon will no longer appear in the
taskbar. To get the taskbar icon to appear again, select Tools >Background Services, enable
“Always Start Avid Editor Services at Launch” and rvestart the application.

To Start, Stop or Pause the Avid Services from within the Editing Application:
1. In the editing application, select Tools > Background Services.

The Background Services window opens.
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Atfter Installing the Editing Application

2. Choose from the following options:

Option

Description

Start

Stop

Pause

Always Start Avid
Background Services at
Launch

Always Stop Avid
Background Services upon
Exit

Immediately starts the background services if they are currently
stopped.

Immediately stops the background services if they are currently
running.

Allows you to explicitly pause the background services for the
specified amount of time. This might be useful if you are
experiencing a slow down due to background services and need
to temporarily stop the services from running.

If the pause time period ends and you are in the middle of a play
operation, the pause time period is extended.

If you quit the editing application while the system is
paused, the system will clear out the pause so that
background services can resume.

Select this option if you want the background services to start
when you launch the editing application.

Select this option if you want the background services to stop
once you exit the editing application.
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Notes on Windows

Option Description
Enable Pausing of Select this option if you want to enable Pausing of the
Background Service background services. Pausing can either be explicit using the

Pause button in this dialog, or it can be automatically performed
during critical Ul operations such as playback, capture, and
when using the Artist Surface.

If you uncheck this option and click OK, the pause state is
cleared out and background services will resume.

3. Click OK.

The services are either Active, Inactive or Paused depending upon the options selected.

Notes on Windows

Note the following topics if you are running the editing application on the Windows OS.

Disabling Desktop Compositing

When the Avid editor is launched you might see a dialog box asking you to disable desktop
compositing. You can disable it without adversely affecting the Avid editing application.

You can choose to disable it and continue with your editing session. The dialog will appear once
you relaunch the application unless you disable the option.
To disable the desktop compositing:
1. Access the Control Panel.
Double-click System.
Click Change Settings.
Click the Advanced tab.

. Under the Performance area, click Settings.

SRV

. Uncheck “Enable desktop composition.”

The dialog box requesting you to disable desktop compositing does not appear the next time
you launch the editing application.
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Notes on Software Licensing

Notes on Software Licensing

Avid Media Composer with Symphony Option

With this release of the editing application, the Symphony editing application is no longer sold as
a separate application. You can buy the Symphony features (Secondary Color Correction and
Universal Mastering) as an option of the Media Composer application.

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first
deactivate your software. After you upgrade your operating system and, if required, reinstall
your application, you can reactivate your software. For information on activating and
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends a minimum of 8GB of RAM. Some features might require
more RAM and specific hardware. See “Feature Performance” on page 41 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance”
on page 41 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware.

For 3rd-Party Open IO hardware qualification refer to the manufacturer’s documentation. See the
Open 10 Frequently Asked Questions document on the Knowledge Base:
http://avid.force.com/pkb/articles/en_US/fag/en422991

The following tables also list the qualified Operating Systems. Depending upon your hardware
the qualified Operating Systems are:
*  Windows v7 64-bit SP1(Professional) and Windows v8, v8.1 (Professional and Enterprise)

*  (Media Composer) Macintosh v10.7.5, v10.8.4, v10.8.5, and v10.9
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Qualified Hardware and Operating Systems

Macintosh OS Permission Information

As of Macintosh OS 10.7 Lion, the default permissions for the root level of the system drive are
now set to “Read Only” for all users. This prevents the Avid Editing Application from being able
to use this drive as a media drive. You will see the drive grayed out in Media Creation settings or
as an option for import, mixdown, render, and consolidate/transcode.

If you don’t intend to use the system drive for media you can leave it alone. This is ideal in most
cases.

If you do need to use the system drive, perform the following to change permissions.

To change permissions:
1. Click on your system drive (Macintosh HD in most cases) to highlight.
2. From the File menu select Get Info (cmd+I)
3. Click the lock icon in the bottom right to make changes
4

. Click on the “Read only” text in the Privilege column next to Everyone and set the privilege
to “Read & Write”

You should now be able to see the system drive as a valid media drive.

If you repair permissions on the system drive, they will reset and you will have to repeat this
procedure.

Macintosh v10.8.x and AVCHD
If you are working with AVCHD and have Macintosh v10.8.x (Mountain Lion) OS installed in
your system, the AVCHD folder will appear as a QuickTime icon. When performing an AMA
Link, you must right+click the AVCHD QuickTime icon and select Show Package Contents.

Then you can see the BDV folder. Right +click the BDV folder and select Show Package
Contents. Then you can see the files needed to perform an AMA Link.

Qualified Workstations and Laptops

The following tables list the qualified workstations and laptops for Media Composer and
NewsCutter editing applications.

Qualified PC Workstations with Avid Media Composer and Avid NewsCutter

The following PC Workstations are qualified with Avid Media Composer and NewsCutter.
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Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

HP z820 Dual 8 Core Intel Xeon E5-2665 2.4
GHz

The HP z820 has not been qualified as a
MediaNetwork client.

HP z820 Dual 6 Core Intel Xeon E5-2640 2.5
GHz

The HP z820 has not been qualified as a
MediaNetwork client.

Lenovo D30 Dual 6 core E5-2640 2.5Ghz or
Dual 8 core E5-2660 2.2 GHz 16 GB
DDR3-1600 memory

Lenovo C30 Dual 6 core E5-2640 2.5GHz or
Dual 8 core E5-2660 2.2 GHz 16 GB
DDR3-1600 memory

Dell T7600 Dual 8 core Intel E5-2665 2.4 GHz
16 GB DDR3-1600 memory

Dell T5600 Dual 6-core Intel E5-2630 2.2 GHz
16 GB DDR3-1600 memory

Lenovo ThinkStation E31, "Intel Xeon
E3-1245V2 3.40 GHz 8 GB DDR3-1600 RAM

HP z800 Dual 6 Core, 2.66 GHz

HP z800 Dual Quad Core, 2.93 GHz or 2.66GHz

HP z420 6-core Intel E5-1650 3.2 GHz 8 GB
DDR3-1600 memory

The HP 7420 has not been qualified as a
MediaNetwork client.

NVIDIA Q4000 or
K4000

NVIDIA Q4000 or
K4000

NVIDIA Q4000 or
K4000

NVIDIA Q4000 or
K4000

NVIDIA Q4000 or
K4000

NVIDIA Q4000 or
K4000

NVIDIA Q600 or
K600 graphics
adapter or integrated
Intel HD Graphics
P4000

NVIDIA
FX Quadro 4800 and
Q4000

NVIDIA
FX Quadro 4800 and
Q4000

NVIDIA Q2000 or
K2000

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX
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Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Lenovo S30 6-core Intel E5-1650 3.2 GHz 8 GB
DDR3-1600 memory

Dell T3600 6-core Intel E5S-1650 3.2 GHz 8 GB
DDR3-1600 memory

HP 2400 Single 6 Core 3.33 GHz

HP 2400 Single Quad Core, 3.06 GHz or 2.93
GHz

HP 7220 Quad Xeon E3-1245V2 3.4 GHz 8 GB
DDR3-1600 memory (Tower or SFF)

HP Z1 Quad Xeon E3-1245V2 3.4 GHz 8 GB
DDR3-1600 memory All-in-One

Lenovo ThinkCentre Edge 927 i7-3770S 3.1
Ghz 8 GB DDR3-1600 memory  Quad core
All-in-One

HP 2210 Quad Core Xeon 3.3- E3-1240, 3.4
E3-1270, 3.5 E3-1280

HP 2200 Intel® Core™ i5-660 3.33 4MB/1333
Dual-Core

Dell™ T5500 Dual 6 Core, 2.66GHz

Dell T5500 Dual, 2.93GHz Quad Core

Dell T3500 Single 6 Core, 3.2GHz

Dell T3500 Single Quad Core, 2.93GHz

NVIDIA Q2000 or
K2000

NVIDIA Q2000 or
K2000

NVIDIA
Quadro FX 3800
Quadro 2000

NVIDIA
Quadro FX 3800
Quadro 2000

Q600 or K600
HD4000

NVIDIA K1000M

Intel HD4000

Quadro 600

NVIDIA
Quadro 600

NVIDIA
Quadro FX 4800
Quadro 4000

NVIDIA
Quadro FX 4800
Quadro 4000

NVIDIA
Quadro FX 3800
Quadro 2000

NVIDIA
Quadro FX 3800
Quadro 2000

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only

Software Only

Software Only

Software Only

Software Only

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX

Software Only
Nitris DX
Mojo DX
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Qualified Hardware and Operating Systems

Qualified PC Hardware Graphics Card Supported with
HP xw8600 Dual Quad Core, 3.0 GHz NVIDIA Software Only
Quadro FX 3700 Nitris DX
Mojo DX
Dell T5400 Dual Quad Core, 2.5 GHz or 3.15  NVIDIA Software Only
GHz Quadro 3700 Nitris DX
Mojo DX

Qualified PC Notebooks for Avid Media Composer, and Avid NewsCutter
The following PC Notebooks are qualified with Avid Media Composer and Avid NewsCutter.
The following applies to the editing system when running on a laptop:

*  DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading
enabled. Nitris DX is not supported on laptops.

*  Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.
*  Playback in full quality 10 bit mode is not supported

Qualified PC Notebooks Graphics Cards Supported With

Lenovo ThinkPad W530 NVIDIA Quadro Software Only

"Intel Core 17-3720QM 2.6 GHz, 17-3820QM  K1000M or Mojo DX

2.7GHz, 17-3920XM 2.9GHz K2000M

HP 8770w i7-3720QM 2.6 Ghz, 17-3820QM  NVIDIA Quadro Software Only

2.7Ghz, 17-3920XM 2.9GHz 17" 1920x1080 - K3000M or Mojo DX

8 GB 1600MHz DDR3 Memory K4000M

HP 8570w 17-3720QM 2.6GHz, i17-3820QM  NVIDIA Quadro Software Only

2.7 GHz 15" 1920x1080 - 8 GB 1600Mhz K1000M or Mojo DX

DDR3 Memory K2000M

Dell M6700 17-3740QM 2.7 GHz 17" NVIDIA Quadro Software Only

1920x1080 - 8 GB 1600Mhz DDR3 Memory ~ K3000M or Mojo DX
K4000M

Dell M4700 17-3740QM 2.7 GHz, 15" NVIDIA Quadro Software Only

1920x1080 - 8 GB 1600Mhz DDR3 Memory ~ K1000M or Mojo DX
K2000M

HP 8760w 17-2820Q), 17-2820Q 2.2 or 2.3 GHz NVIDIA Software Only
Quadro 3000M Mojo DX
Quadro 4000M
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Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With

HP 8560w, 17-2720Q, 2820Q, 2.2 or 2.3 GHz  NVIDIA Software Only
1771920 x1080 Quadro 1000M
Quadro 2000M
Dell M6600, 17-2720Q, 2820Q, 2.2 or 2.3 GHz NVIDIA Software Only
1771920 x1080 Quadro 3000M Mojo DX
Quadro 4000M
Dell M4600, 17-2720Q, 2820Q, 2.2 or 2.3 GHz NVIDIA Software Only
1571920 x1080 Quadro 1000M Mojo DX
Quadro 2000M
HP 8740w X820, X920 Quad i7 (1.73, 2.0 NVIDIA FX Software Only
GHz) 2800M Mojo DX
17" 1920x1200 NVIDIA FX
3800M
HP 8540w X720, X820 Quad i7 (1.6, 1.73 NVIDIA FX Software Only
GHz) 1800M Mojo DX
15" 1920x1080
Dell M6500 i- 820Q, i7-840Q, 17-920X(1.73,  NVIDIA FX Software Only
1.87,2.0 GHz) 2800M Mojo DX
17" 1920x1200 NVIDIA FX
3800M

Qualified Macintosh Workstations for Avid Media Composer

The following Macintosh Workstations are qualified with the Avid Media Composer.

Qualified Macintosh Hardware Graphics Cards Supported With

Mac Pro “Westmere” Two 2.66GHz 6-Core  ATI Radeon HD 5770 Software Only
Intel Xeon (12 cores) Nitris DX
Mojo DX

Mac Pro “Nehalem” 2.66 GHz or 2.93 GHz NVIDIA GeForce Software Only
Dual Quad Core Intel Xeon GT 120 Nitris DX
Mojo DX
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Qualified Hardware and Operating Systems

Qualified Macintosh Hardware Graphics Cards Supported With
Mac Pro “Nehalem” Dual 2.26 GHz Quad =~ NVIDIA GeForce GT Software Only
Core Intel 120
Mac Pro “Harpertown” Dual Quad Core 3.0 NVIDIA GeForce Software Only
or 3.2 GHz 8800 GT Nitris DX

Mojo DX

iMac 27” 2.9GHz Quad-core Intel i5, 3.2Ghz NVIDIA GeForce Mojo DX (Thunderbolt)

Quad-core Intel i5, 3.4 GHz Quad Core Intel GTX 660M or Software Only
i7 NVIDIA GeForce
GTX 675MX
iMac 21.5” 2.9GHz Quad-core Intel i5, NVIDIA GeForce Mojo DX (Thunderbolt)
3.1GHz Quad-core Intel i7 650M Software Only
iMac 27” Display Quad Core 3.4 GHz ATI 6970M Mojo DX (Thunderbolt)
Software Only
iMac 27” Display Quad Core 2.93 GHz ATI 5750 Software Only
iMac 21.5” Display Dual Core 3.6GHz ATI 5670 Software Only
iMac 27” Display 2.8 GHz 4 GB Quad Core ATI Radeon HD 4850 Software Only
1066MHz Graphics Processor
Mac mini 2.3/2.6GHz quad core Intel i7 Intel HD 4000 Mojo DX (Thunderbolt)
Software Only
Mac Mini Server 2.0 GHz i7 Quad core Intel Mojo DX (Thunderbolt)
Thunderbolt - 4GB 1333MHz DDR3 3000 Software Only

Qualified Macintosh Notebooks for Media Composer
The following Macintosh notebooks are qualified with the current editing applications. The
following applies to the editing system when running on a laptop.
*  HD Capture on Macintosh notebooks is not supported
*  Playback in full quality 10 bit mode is not supported

Qualified Macintosh Notebook Graphics Cards Supported With
MacBook Air 13" - 2.0 GHz 17 Dual-Core Intel HD4000 Mojo DX (Thunderbolt)
Thunderbolt - 8 GB 1600MHz DDR3L Software Only
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Qualified Macintosh Notebook

Graphics Cards

Compatibility Chart

Supported With

MacBook Air 13”
1.7GHz Dual-Core Intel Core i5 or
1.8GHz Dual-Core Intel Core 17

MacBook Pro 15" 2.3/2.6/2.7 GHz 17
Quad-Core - Retina & Thunderbolt

8 GB 1600Mhz DDR3L Memory

MacBook Pro 17"
2.2/2.3/ GHz Quad Core i7

MacBook Pro 15"
2.0/2.2/2.3GHz Quad Core i7

MacBook Pro 15"
2.53GHz Dual Core i5
15” or 17” 2.66GHz Dual Core i7

Intel
3000

HD4000
GeForce GT 650M

6750M
Intel
3000

6490M
6750M
Intel
3000

GT 330M

Mojo DX (Thunderbolt)
Software Only

Mojo DX (Thunderbolt)
Software Only

Mojo DX (Thunderbolt)
Software Only

Mojo DX (Thunderbolt)
Software Only

Software Only
17” only - Mojo DX (no
DNxHD capture)

Compatibility Chart

The following table lists the NVIDIA® driver, QuickTime®, Windows Media™, shared storage,
Sony® XDCAM™, Panasonic® P2, and Pro Tools LE® versions that were qualified with the Avid
editing applications. Also listed are the third-party applications such as Boris Continuum
Complete, Avid DVD by Sonic™, and Sorenson Squeeze®.

Item Versions

Comments

QuickTime Support

Windows Media

Version Support Windows 7)

v7.7.4 (Windows)
v10.x, (v7.x legacy) (Macintosh)

Windows Media Player 12 (for

Note: QuickTime v10X does not include

QuickTime Pro options.

If you do not have Windows Media

Player, access the download at
www.microsoft.com.

Windows Media export compatibility is
subject to Microsoft Windows Media

updates.

33


http://www.microsoft.com/en/us/default.aspx

Compatibility Chart

Item Versions Comments

Avid Interplay Search the Knowledge Base for

Support “Avid Editing Application

Compatibility with Interplay
Releases.”
NVIDIA Driver v320.78 (Windows v7 and v8) See “Setting up the NVIDIA Card” on
Support Vv331.65 (Windows v8.1 page 39. , ,
For setting up the driver for stereoscopic,
see the NVIDIA setup info in the
Stereoscopic 3D Workflow Guide.

Shared Storage Avid Unity™ MediaNetwork and  See “Shared Storage Support” on

Support Avid Unity ISIS®. page 41.

Pro Tools * For information on supported
versions of Pro Tools in an Interplay
environment, see the Avid Interplay
ReadMe or
http://avid.custkb.com/avid/app/selfs
ervice/search.jsp?Docld=353977&Hi
lite=Pro+Tools+Interplay

* For Co-install information, see Avid
Editing Application Compatibility
with Pro Tools.

¢ For Video Satellite information, see
the Video Satellite Guide or
http://avid.custkb.com/avid/app/selfs
ervice/search.jsp?Docld=354337&Hi
lite=video-+satellite

Sony XDCAM driver v2.13 (XDCAM Transfer for The VFAM firmware version is 2.45. The

Panasonic P2 drive

Boris Continuum
Complete

Macintosh)

Win 7-64 FAM 2.3.2 and VFAM
4.0.1

(Macintosh) No device support
for Lion

(Windows 7) Driver version for
P2 devices:v2.16

v8.1.1

driver can be downloaded from Sony's
website http://esupport.sony.com/.

There is currently no P2 writeback
support for Macintosh clients.

Ships with:
Avid Media Composer with Symphony
option
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Avid Editing Application Compatibility with Pro Tools

Item Versions Comments
Avid DVD by Sonic  v6.4.4 Ships with:
Avid Media Composer
Avid NewsCutter
Sorenson Squeeze v8.5 Ships with:
Avid Media Composer
Avid NewsCutter
Avid FX v6.4 (Windows) Ships with:
. Avid Media Composer
6.4 (Macintosh
v6-4 (Macintosh) Avid NewsCutter
iZotope Insight iZotope Insight is automatically  Ships with:
installed with the editing Avid Media Composer
application and is a 30 day trial. ~ Avid NewsCutter
The trial will start once the RTAS
plug-in is inserted onto an audio
track.
For information on iZotope
Insight, see www.izotope.com
NewBlue Titler Pro  Titler Pro v1 is automatically Ships with:
vl installed with the editing Avid Media Composer
application and is a full version ~ Avid NewsCutter

Avid Artist Series
(Euphonix)

that does not need a serial number.

For information on NewBlue
Titler Pro v1, see
www.newbluefx.com.

EuControl software v2.6.2 or later

See the User’s Guide for information on
Artist Series Color setup information.

Avid Editing Application Compatibility with

Pro Tools

General Co-Installation Notes:

* Install Pro Tools first and then Media Composer.

*  You must uninstall all older versions of Media Composer or Pro Tools before installing

newer versions.

*  Co-install does not support both applications launched simultaneously.
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Co-installation Configurations and Audio Device Support

*  When you uninstall Pro Tools, choose to uninstall just the application and not the audio
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 10
system, this is named the “Safe Uninstall.” On a Macintosh Pro Tools 11 system no
uninstallation is required. On a Windows Pro Tools 10 or 11 system, you must select the first
uninstall option - “Pro Tools Only” - which is not selected by default.

*  Mojo SDI will not be supported with Media Composer or Pro Tools 11, but can still be
connected in a co-install configuration for use with Pro Tools 10.

* Ifyou install and configure Avid Mojo DX or Nitris DX hardware on your system, the
editing application does not use any connected Pro Tools audio device for audio input/output
operations. You can also use these audio devices with a software-only version of your Avid
editing application (Media Composer and NewsCutter).

* Ifyou run into any issues, uninstall both applications and reinstall Pro Tools first, and then
reinstall your editing application.

*  Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x
and Pro Tools v8.0.1 instead.

* Ifyou want to install your Avid editing application on a system with the Pro Tools Avid
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.

Co-installation Configurations and Audio Device
Support

Avid Pro Tools Applications

MC/NC MC/NC
Pro Tools Software with Mojo MC/NC/
Product Only DX with Nitris DX
Pro Tools Co-install Co-install Co-install

Software Only

Pro ToolsfHD  Co-install/ Co-install Co-install
Native Audio Device

Pro ToolsHD  Co-install/ Co-install Co-install
Audio Device
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Co-installation Configurations and Audio Device Support

MC/NC MC/NC

Pro Tools Software with Mojo MC/NC/
Product Only DX with Nitris DX
Pro Tools]HD, Not Tested ~ Not Tested ~ Not Tested
with chassis

Avid Mbox Family Audio Devices (3rd Generation)
Audio MC/NC
Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox Co-install/ Co-install Co-install
(USB) Audio Device
Mbox Pro Co-install/ Co-install Co-install

Audio Device

Mbox Mini  Co-install/ Co-install Co-install
(USB) Audio Device

Avid Mbox 2 Family Audio Devices
Audio MC/NC
Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox 2 Co-install/ Co-install Co-install
(USB) Audio Device
Mbox 2 Pro Co-install Co-install Co-install
(1394)
Mbox 2 Co-install/ Co-install Co-install
Mini (USB) Audio Device
Mbox 2 Co-install Co-install Not tested
Micro
(USB)
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Other Avid Audio Devices

Audio MC/NC
Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Digi 002 Co-install/ Co-install Co-install
(1394) Audio Device

(Windows)
Digi 003 Co-install Co-install Co-install
(1394)

Eleven Rack Not Supported Not Supported Not Supported
(USB)

Fast Track  Audio Device Not Supported Not Supported
Pro (USB)

External Controllers

Your Avid editing application supports the following external fader controllers or mixers for
automation gain and pan recording or as control surfaces:

Digi 002 (Windows only — Media Composer and NewsCutter)
Command|8

Avid Artist Control

Avid Artist Mix

Avid Artist Transport

Avid Artist Color

External controllers or mixers are optional. They are not required for you to perform automation
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Digi 002 Avid Artist Avid Artist Avid Artist Avid Artist
Feature (MC/NC only) Command|8 Control Mix Transport Color
Control surface Yes Yes Yes Yes Yes
for transport (transport
controls and only, no soft
other functions keys)
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Digi 002 Avid Artist Avid Artist Avid Artist Avid Artist
Feature (MC/NC only) Command|8 Control Mix Transport Color
Provides audio  Yes No No No No
play, input, and
output
Record Yes Yes Yes Yes No
automation gain
Record Yes Yes Yes Yes No
automation pan
Flying faders Yes (8) Yes (8) Yes (4) Yes (8) No
Touch-sensitive Yes Yes Yes Yes No
faders
Touch-sensitive No No Yes Yes No
panners
Solo/mute Yes Yes Yes Yes No
Supports audio No? No No No No
mixing
Latch mode Yes Yes Yes Yes No
(also known as
Snap mode)
Number of 1024 1024 1024 1024 Not applicable
steps of fader
accuracy

a. The Digi1 002 can be used as a standalone audio mixer but not at the same time as 1t 1s being used as an automation gain or
automation pan controller or control surface.

For more information on using these external fader controllers or mixers, see “Recording

Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version
(install the display driver if necessary, and set the correct display settings. See the “Compatibility

Chart” on page 33 for information on the supported driver(s).
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Setting up the NVIDIA Card

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities folder
that installs with your Avid application.

Installation files for these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.
To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.
The version number is listed in the Graphics card information section on the ForceWare
version line.
To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \Utilities \nVidia and double-click the folder that
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:
1. Right-click the Desktop, and select Nvidia Control Panel.
2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.

To set the Driver for Avid Editing Environments
1. Right-click the Desktop, and select Nvidia Control Panel.
. Click Manage 3D Settings.
. Click the Global Setting tab.
. Under Global presets, select Base Profile.
. Scroll to locate the Power Management Mode. Select Prefer maximum performance.
. Click Apply.

AN W A W

Reboot after installing the Nvidia software even if you are not prompted to do so.
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must
match the rest of the components the Nvidia installer installs.
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Shared Storage Support

*  There is no support for ethernet attached clients in a MediaNetwork environment.

*  MediaNetwork clients are not supported with Media Composer v7.0 and NewsCutter v11.0
in an Interplay v3.0 environment.

The editing application has been tested in a shared storage environment with the following.

Editing ]
Application ISIS 5500 | ISIS 7500 | Media- Media-
Operating  ISIS 5000 ISIS2000 7000 Network Network
System Clients Server Server Server Client? Server
Windows 8 v4.5,v4.6 v4.0.1, v4.1,v4.2, v4.0.1, not supported  not supported
v4.0.3, v4.5,4.6 v4.0.3,
v4.0.4, v4.0.4, v4.5,
v4.5.1,v4.6 4.6
Windows 7 v4.2, v3.2,v4.0.1, v4.1,v4.2, v2.4,v4.0.3, v54 v5.1.3
64-bit v4.5,v4.6 v4.0.3, v4.5, v4.6 v4.0.4, v4.5,
v4.0.4, v4.6
v4.5.1,v4.6
Macintosh vv4.6 v4.0.1, va.1,v4.2, v4.0.1, not supported  not supported
Mavericks v4.0.3, v4.5,4.6 v4.0.3,
v10.9 v4.0.4, v4.0.4,v4.5,
v4.5.1, v4.6 4.6
Macintosh v4.2,v45 v3.2,v4.0.1, v4.1,v4.2 v2.4,v4.0.3, notsupported not supported
Mountain Lion v4.0.3 v4.0.4
v10.8.x
Macintosh v5.5.1 v5.1.3
Lion v10.7.5

a. Avid Media Composer v/.0 and NewsCutter vI1.0 will be the last supported version of the editing application with
MediaNetwork shared storage.

Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might
experience problems if you are working on an older system. The following chart shows the
hardware that Avid has successfully qualified when using these features. For a list of the
qualified systems, see Qualified Workstations and Laptops.
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Feature Performance

Feature

Description

Recommended System

DMF and Background
Transcode

Editing High Resolution
Media (Higher than 2K+)

J2K Capture

HD Long GOP 9-way
MultiCam with high
stream count sequences

Stereoscopic 3D

XDCAM HD50 Capture

HD RGB 4444
ProRes 4444
DNxHD 4444

AMA (RED)

AMA (QuickTime)

8 GB RAM minimum. 16 GB
RAM recommended

8 GB RAM minimum. 16 GB
RAM recommended

Avid recommends 16 GB RAM

For optimal performance with
Stereoscopic 3D, use these higher
performance systems. Avid
recommends a minimum of 12GB
RAM when using Stereoscopic
3D.

Baseband capture through Nitris
DX, Mojo DX

HD RGB capture requires a high
end workstation with Nitris DX
and fast storage.

AMA is a processor intensive
operation. Older platforms may
not offer optimum performance.
you will get better performance
with higher end workstations.

AMA is a processor intensive
operation. Lower end platforms
may not offer optimum
performance. Highly compressed
codecs such as H.264 will exhibit
minimal real-time performance.

See Qualified Workstations

Qualified Dual 6 Core, Dual 8 Core
systems

Qualified Dual 6 Core, Dual 8 Core
systems

Qualified Dual 6 Core, Dual 8 Core
systems
Storage: 10Gb Ethernet ISIS,

Qualified 6 core Xeon Workstations

Qualified 6 core Xeon Workstations

Qualified Dual 6 Core, Dual 8 Core
systems
Storage: 10Gb Ethernet ISIS,

Qualified Xeon Workstations

Recommendation of qualified systems
depends on your planned use of this
feature. Heavy usage of highly
compressed codecs requires the high end
systems. (Dual 6 Core or Dual 8 Core
systems)
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Feature Description Recommended System

AVCl-Intra AVC-Intra(AVC-I) is a high 4-Way MultiCam Playback

‘ﬂuahty’ low b'1t-rate. HD codec and Dual Quad Core, Dual 6 Core or Dual 8
is very CPU intensive.
Core Systems

Four Stream Playback:

Dual Quad Core, Dual 6 Core or Dual 8
Core Systems

Limitations
The following limitations apply to the current version of the editing application.

AMA

»  Bug Number: . Since a given file type may be supported by multiple AMA plug-ins, for best
results choose a specific AMA plug-in rather than Autodetect when performing an AMA Link to
File. When performing an AMA Link to a volume, Autodetect will normally select the correct
plug-in, but if it doesn't, choose a specific AMA plug-in and perform the AMA Link to volume
again.

»  Bug Number: UDevC00182286. When performing an AMA link to MXF media, you should
not select the Autodetect plug-in option. Choose the applicable plug-in to perform the AMA
Link to File.

»  Bug Number: UDevC00179996. If you load an AMA-linked clip into a monitor, then enable
Dynamic Relink and set the Preferred media format in the Dynamic Relink Settings dialog box
to “Any native media,” the media displays as offline. This is as designed. If there is no native
MXF or OMF media to display, the AMA-linked clips only display when you select AMA as the
preferred media format.

»  Bug Number: UDevC00178140, UDevC00180089. If you are AMA linking BlackMagic
Cinema Camera DNxHD movies, these files link as Matte Key effects rather than master clips.
Therefore these files cannot be transcoded. To workaround this, open Import Settings, and in the
Image tab set Alpha Channel to Ignore.

»  Bug Number: UDevC00180039. Media Indexer limitation: When you check in an AMA file,
the system does not create .spaaf files if the workspace for .spaaf files is not mounted correctly
on the ISIS client. Before you begin to check the AMA files into Interplay, you must manually
create the top level folder for the .spaaf files and configure the Media Indexer to index that
folder. Avid recommends that you dedicate a specific workspace for the spaaf files. The spaaf
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workspace on ISIS must be mounted and accessible by the editing user on the editing machine.
On a Mac OS X system, the workspace must be mounted using the same name as the workspace.
The checkin will fail if this condition is not met.

The following shows mount point examples for a workspace named “spaafFiles”:

*  Correct: /Volumes/spaafFiles

* Incorrect: /Volumes/spaafFiles1

The incorrect mount point can occur if you have duplicate workspace names. The ISIS client

adds a digit to a workspace name if it encounters a duplicate name. This can happen if you have
two ISIS systems. Avoid duplicate workspace names.

»  Bug Number: UDevC00179925. AS-11 export currently does not include a data track in the
resulting file.

»  Bug Number: UDevC00178051. Do not enable Audio Waveforms if you are AMA linking to
Arri clips.

»  Bug Number: UDevC00178650. XDCAM AMA linked files might not appear in the Media
Tool. XDCAM AMA linked volumes do appear in the Media Tool.

Avid Artist Color

»  Bug Number: UDevC00157064. Some soft keys do not light up when you use the Avid Artist
Color with your Avid editing application, including the following:
e HSL Shift Layer: all soft keys
*  HSL Bank 2 Shift Layer: all soft keys
*  Curves: F8 and F9 soft keys
*  Curves Shift: F1, F3, F6, and F9 soft keys
*  Secondary: F2, F7, F8, and F9 soft keys
e Secondary Shift: all soft keys
The soft keys listed above function normally even when they do not light up.

»  Bug Number: UDevC00163957. Hue offset color wheels might not appear when you use Artist

Color to enter Color Correction mode the first time after start your Avid editing application. Any
parameter update will draw them.

Workaround: When you make any change in a parameter in the Color Correction tool, the
color wheels appear.
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»  Bug Number: UDevC00156948. (The F2 soft key (Next HSL Subtab) does not function until
after you apply a color correction to your footage. If you press F2 (Next HSL Subtab) on the
Atrtist Color surface before you apply a color correction, you get a system beep and the subtab
does not change.

»  Bug Number: UDevC00157932. If you use the HSL shift control for trackballs, you might see
the trackballs controlling the wrong monitor during shuttle. For example, if you press Shift and
then use the right trackball to shuttle, and then move either the left or the center trackball, you
might see the other trackballs now control the right monitor.

»  Bug Number: UDevC00164772. When you first ope n the Color Correction tool, either with the
Atrtist Color or with the mouse, incorrect color correction values might display in parameter
fields. This problem is intermittent, and it does not occur after you change a parameter value.

Workaround: Adjust any parameter. The correct values display in the Color Correction tool.

»  Bug Number: UDevC00164954. (Macintosh only): The EuControl application does not open
when you select Edit Settings in the Controller Settings dialog box. To configure your EUCON
device, you must open the EuControl application by clicking the EUCON icon in the dock, and
then selecting Window > EuControl Settings.

Background Transcode

»  Bug Number: UDevC00178938. The Background Queue window might stop refreshing
intermittently. Select Open Background Queue window from the task bar (Windows) or menu
bar (Macintosh) to view the background status in a browser.

»  Bug Number: UDevC00180218. If you perform an ‘alldrives” Console command and mount a

network drive, a background transcode will not be successful to the mounted network drive. A
foreground transcode will transcode successfully.

Capture

»  Bug Number: UDevC00181736. If you are on a Windows 8 system, you might notice a slight
stutter while recording (or in Capture Mode) but the video will record without any skips or
dropped frames.
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Compatibility

>

DMF

Bug Number: UDevC00166431. You might receive AMPI Subsystem errors when launching
the editing application. Avid recommends that you refer to the following Knowledge Base article
for information on possible causes.
http://avid.custkb.com/avid/app/selfservice/search.jsp?Docld=377091

Bug Number: UDevC00151588. You must have the MediaNetwork client installed on your
system in order to play linked AMA clips from the MediaNetwork shared storage.

Bug Number: . The Standalone Transfer Manager will be supported with this release, except for
compatibility with Airspeed Classic and Open I/O devices.

Bug Number: UDevC00173830. When attaching and detaching the Nitris DX hardware the
system might restart.

Bug Number: UDevC00180779. If you select the QuickTime folder plug-in from the DMF drop
down menu and attempt to link to QuickTime files inside the DMF watch folder, an error
message will occur stating the files cannot be linked and the DMF process will terminate.

Workaround: Select the Autodetect AMA Plug-in from the DMF drop-down menu to link to
QuickTime files and/or folders.

Bug Number: . If you are using a removable drive or reader as a DMF watch folder, make sure
that “Automatically AMA-link to volumes” is deselected in the AMA Settings.

Bug Number: . The following media types are not currently supported with Dynamic Media
Folders in Media Composer:

*  Uncompressed 8bit and 10b QuickTime files
¢ QuickTime files that include an alpha channel
*  Sony XDCAM-EX
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Effects

>

Limitations

Bug Number: . AVX 1 effects are no longer supported and will not be recognized in this latest
version of Media Composer. Please contact the respective 3rd-party plug-in vendor for an AVX2
64-bit version of any existing plug-in that you might have purchased. The following Avid AVX1
effects will automatically be promoted to AVX2:

¢ Avid Pan & Zoom
*  Region Stabilize
* RGB Keyer

When you load a previously-generated sequence containing one of these effects, they will
automatically be promoted to new corresponding AVX2 effects. These effects will not be
recognized by earlier versions of Media Composer.

Modifying Pan Values in the Timeline: You can display different pan values in the Timeline for
different audio tracks by clicking the Clip Gain/Pan button in the Track Control panel and
selecting one of the pan value options. However, if you want to manipulate pan control points
(either adding a keyframe or adjusting a keyframe), you must make sure all audio tracks display
the same pan values. To do this, Alt+click the Clip Gain/Pan button in the Track Control panel
for any audio track and select a pan value option.

Interplay

>

Bug Number: . (Interplay) Dynamic relink is not currently supported for media that requires
pulldown. Therefore, you can only use it with clips where the media has been acquired at the
native frame rate (without pulldown).

Bug Number: . (Interplay) Pro Res formats can only be used by Avid editing applications that
are in a non-Interplay environment. For any additional limitations regarding running an Avid
editing application in an Interplay environment, see the Interplay ReadMe.

Bug Number: UDevC00164931. (Avid Interplay and Windows 7) Can't locate Media Indexer
on Avid editor after first install. After an initial installation of the editor and Interplay support
software, the editing application may fail to locate the Media Indexer. This can happen if some of
the Avid Service Framework services have not started correctly.

Workaround: Open the Workgroup Properties tool on the editor and check whether any of the
services are not running. Restart any services as required. Then restart the Avid editing
application again. You may have to do this the first few times that you start the editor. After a few
times the services will begin starting automatically, even after a reboot.
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iXML Metadata in BWAV Files

»  Bug Number: . Multi-channel track identification information is not read from iXML

»  Bug Number: . Markers in the iXMI are not imported when the file is linked.

»  Bug Number: . Implied channel group information by file name pattern, as used by the audio
import code, is not available when using the WaveAIFF AMA.

»  Bug Number: . Channel group information, the iXML data that is used to group multiple mono
files into a single clip, is not interpreted. To workaround this, reconstruct the channel groups
manually with AutoSync.

To reconstruct the multi-channel track identifications, set in the AMA setting link options for
Multichannel audio prior to linking, or edit afterward with multi-channel audio pane of clip
menu “modify” dialog.

Output

»  You cannot control down/cross conversion from the Video Output Tool when in TrueP mode for
1080p projects or when you are in Stereoscopic mode.

Workaround: When in stereoscopic mode or have True Progressive output set for 1080p

projects, the down-convert and cross-convert options are not available. To output at a rate

different than the project format, go to the Format tab and change the output project setting.
Performance

»  Bug Number: UDevC00179008. Foreground performance of the application could be impacted
while waveforms cache for systems attached to XDCAM EX device.

PhraseFind

»  Bug Number: UDevC00166649. For best results with PhraseFind, Avid recommends using

Avid certified storage solution.
Play
»  Bug Number: UDevC00153838. You might receive an “Exception: The sequence or one of its

source elements is too long to be played” error if you have a sequence over 12 hours.
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QuickTime

>

Bug Number: UDevC00159820. QuickTime Reference movies are not supported by
QuickTime Player X. They are still supported in QuickTime Player 7 on the Macintosh. They are
also not supported in QuickTime version 7.6.9 on Windows.

Project Sync

>

Bug Number: UDevC00179779. If you use Interplay Assist to create shotlists, you can save the
shotlists in a folder within a synced project folder in your Interplay database. However, updating
the synced project from Media Composer or NewsCutter does not update the bin with the
shotlist. This is as designed. The Interplay synced project workflow uses projects created and
edited in your Avid editing application and then saved to Interplay so other Media Composer or
NewsCutter users can access the same project.

Workaround: Create your shotlists in Media Composer or NewsCutter and then update your
project. The shotlist appears in the synced project folder in Interplay as well as in the bin in your
editing project.

Bug Number: UDevC0017968. If you create a new synced project, delete it before opening the
project on your Avid editing machine, and then add the project from Interplay and open it, the
project is empty and contains no bins. This results from creating a synced project, which creates
the necessary synced project folder in your Interplay database, but not creating any content for
the project.

Workaround: If you open a project that has no content, you can create a new bin. The new bin
is saved to Interplay, which then creates the folder structure for the media in your synced project.

Bug Number: UDevC00179847. Opening a bin from another project while you work in a
synced project does not add that bin to the project saved to Interplay, and updating a synced
project from Interplay does not update a bin opened from a different project. Only bins that are
part of an Interplay synced project are saved to Interplay.

Workaround: If you want to add media from another project to your Interplay synced project,
create a new bin and add the media directly to it. When the bin is saved to Interplay, your synced
project updates correctly.

Bug Number: UDevC00180164. You cannot update a sequence from Interplay in a synced
project by right-clicking the Source or Record monitor and selecting Update from Interplay.
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Workaround: To update a sequence in a synced project, click the bin with your sequence to
activate it, and then select File > Save Bin, or select the bin, and then select Bin > Update Bin
from Interplay. For more information on saving sequences to Interplay, see “Updating a Synced
Project” in the Help for your Avid editing application.

Bug Number: UDevC00180195. If two or more editors are working on the same Interplay
synced project, deleting folders and bins by one user might create conflicts and cause the second
user’s editing application to become unstable. This can happen when one editor moves a folder
that contains a bin to the Trash and then saves the project. This updates the project on Interplay.
If a second editor working on the same synced project at the same time has the bin open, updates
his project from Interplay, the now-deleted bin stays open in the local project even though the
Trash folder shows the bin has been deleted. If the second editor then makes a change to this bin
and tries to save it, the editor receives an error stating that the bin has been deleted from
Interplay. This error message might appear several times. If the second editor dismisses the error
messages and tries to close the bin, an assertion error appears and the application becomes
unresponsive.

Workaround: Avid recommends that you do not delete folders from your Interplay synced
project if other users are working on the same project simultaneously.

Stereoscopic 3D

>

A software developer's kit is now available for 3rd-party partners who would like to build AMA
plug-ins, AVX2 effects, or develop applications that support stereoscopic 3D media/sequences
compatible with Avid Media Composer. This developer's kit is available on the Avid website.

720p Stereoscopic projects are not currently supported with Open I/O hardware from 3rd-party
vendors.

Bug Number: UDevC00164741. If a rolling title is used in an Over\Under stereo project, you
may get the wrong scaling and cropping of lines.

Stereoscopic projects are not supported on Avid Interplay.

Multicam of stereoscopic clips is not supported.
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»  NVIDIA 3D Vision

*  Avid currently only supports the NVIDIA 3D Vision Home bundle (which includes the 3D
glasses, emitter hub and display monitor). The 3D Vision Pro has not been successfully
tested.

*  Full screen playback on an NVIDIA 3D Vision monitor is only supported on a Windows
system.

e Due to an NVIDIA driver issue, the first time that the full screen play window appears, the
application will resize to a single monitor. Resize the application as necessary. You can reset
your window positions by clicking on a toolset in the menu.

»  Bug Number: UDevC00161499. Ancillary data output is not supported if you are working in
full stereoscopic format.

Timeline

»  Bug Number: UDevC00164751. If you have a sequence loaded in the Timeline, and you have
waveforms on, clicking or dragging in the Timeline does not stop the waveform from drawing.

Workaround: Hold Cmd + . to stop the waveform from drawing.
Title Tool

»  Bug Number: UDevC00176468. (Macintosh) Icelandic characters are not supported when
working with the Title Tool. As a workaround, you can use the NewBlue Titler Pro plugin which
does support Icelandic characters.

XDCAM

»  Bug Number: UDevC00177208. XDCAM Multicam media might appear choppy in the
Source/Record monitors when you perform reverse playback with the J key.

»  Bug Number: . You cannot export an XDCAM clip or sequence that is less than 2 seconds long.
User Interface
»  Bug Number: UDevC00162819. You cannot copy and paste timecode values into the Source or

Record monitors. To enter timecode in the monitors, select the monitor and then type in the
appropriate timecode values.
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»  Bug Number: UDevC00164678. You can drag audio keyframes past adjacent audio keyframes.
Moving an audio keyframe past another keyframe causes the keyframes to swap values. For
example, set volume levels on two audio keyframes: Keyframe A for low volume (left keyframe)
and Keyframe B for high volume (right keyframe). If you then drag Keyframe A to the right of
Keyframe B, Keyframe A now displays the higher volume level.

»  Bug Number: UDevC00164995. (Macintosh only) If you load a group clip into the Source
monitor while in MultiCamera mode, the monitor displays the clip as if MultiCamera mode is
still selected, although the action of loading the group clip actually causes the Avid editing
application to enter Source/Record mode. If you play back the clip, you only see the linecut and
cannot perform MultiCamera edits.

Workaround: To turn off the Multicamera mode display, select Special > Multicamera Mode,
and make sure MultiCamera Mode is not selected.

»  Bug Number: UDevC00165159. (Macintosh only) If you render a sequence containing a title
by selecting Clip > Render In/Out or by right-clicking the sequence and selecting Render In/Out,
the progress bar displaying the status of the render operation does not update and the application
appears to become unresponsive. However, even though the progress bar does not advance, the
rendering operation continues. When it completes, the progress bar closes.

Documentation Changes

The following documentation changes were made after the initial documentation release was
finalized. These will be corrected in the next release of the product.

AS-11 Profiles

The Profile option in the “AS-11 Support” topic is not included with this release of the editing
application. Disregard the optional steps included in the procedure in the Help.

iZotope Insight and NewBlue Titler Pro v1 Effects

The editing application installs the iZotope Insight plug-in and the NewBlue Titler Pro v1
plug-in effect. For information on iZotope Insight, see www.izotope.com. For information on
NewBlue Title Pro v1, see www.newbluefx.com.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2013 Avid Technology, Inc. and its licensors. All rights reserved.

Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

003, 192 Digital I/0, 192 1/0, 96 /0, 96i /O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive Il, Assistant
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid
DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid
Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Beat Detective, Beauty
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, CaptureManager, ChromaCurve,
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8,
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 002, Digi 003,
DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction,
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, Digital
Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, Do More, DPP-1, D-Show, DSP
Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander,
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko,
HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image
Independence, Impact, Improv, INEWS, iINEWS Assign, INEWS ControlAir, InGame, Instantwrite, Instinct, Intelligent Content
Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX,
Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link &
Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee,
MassivePack, Massive Pack Pro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media
Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch,
NewsCutter, NewsView, NewsVision, Nitris, NL3D, NLP, NSDOS, NSWIN, OMF, OMF Interchange, OMM, OnDVD, Open Media
Framework, Open Media Management, Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE,
ProControl, ProEncode, Profiler, Pro Tools, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch,
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync,
SecureProductionEnvironment, Serv|GT, Serv|LT, Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude
Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte,
SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC
HD, SYNC 1/0, Synchronic, SynchroScope, Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxider, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Ultilities,
tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID,
VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid
Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows

is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other
trademarks contained herein are the property of their respective owners.
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